JVector User Manual

Introduction

JVector is a vector Image editing program, distributed for free. It runs on numerous platforms, with
the officially supported ones being Windows 2000 & XP, Linux (Kernel 2.4 and higher), and Mac
OS X.

The official website of JVector is located at, http://t-bone-paint.sourceforge.net/, here you can
download the most recent versions of JVector, any new plug-in's, and acquire technical support.

Technical Information

JVector is written in the Java Programming Language. It is an open source project, hosted on
http://sourceforge.net, and distributed under a GNU General Public Licence (GPL). It has been in
development for only a short while, 2 months. It is written by David Terei.
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System Requirements

All computers need the Sun Java VM (JRE), Version 1.4.2 or higher to run JVector, and its
installation program. For information on how to check if you have Java installed on your computer,
or on how to install it, see the trouble shooting located at the end.

Minimum
800 x 600 screen resolution.
16 Bit screen depth.
SMB of hard drive space.
128MB of Ram.
CPU: PC (x86) - Pentium 3 450 MHz or Equivalent.
Mac (PowerPC) — G3

Recommended
1024 x 768 screen resolution.
32 Bit screen depth.
10MB of hard drive space.
256MB of Ram.
CPU: PC (x86) - Pentium 3 800 MHz or Equivalent.
Mac (PowerPC) — G4




Installing JVector

1. Firstly, you must get the JVector installation program, called JVector-install.jar. If you
already have this, then skip to step 4
Open up your web browser and head to
http://sourceforge.net/project/showfiles.php?group id=106356&package id=118502.

2. Once there, under the top heading (which should be the latest version of JVector), click on
the link. (The screenshot below shows this, taken when JVector 0.19prel
was the latest version).

Package o Filename . ate
& Notes Size D/L Arch. Type
Wector
& 1vector 0.19pre1 [show only this release] 2004-06-16 00:00
Jvector-0.186-source.tar.gz 628353 0 Platform-Independent Source .gz

J\/ector-install'!'ar 2067414 0 Platform-Independent Jar
;| ... . - am # o ' - AARs Ar Am AR AR

3. Wait a few seconds or so for the next page to load, once it has, a download window should
pop up asking you where to save JVector-install jar. Save it anywhere you would like.

4. Now locate and double click on JVector-install.jar to begin installing JVector.

5. Now the following window should appear;

1zPack - Installation of JVector Q

': Welcome to the installation of JVector 018!

.7. The author(s) of this software is(are) :
- David Terei =ned2076@users sourceforge.net=

¢ The homepage is : hitp: isourceforge netiprojectst-hone-paint/

(Made with 1zPack - hitp: ey izforge.coms)

[ Onex || Gout |

If it does not appear, then please go to trouble shooting, as your system fails the
requirements.

6. At this window, just press the next button located in the bottom right corner.




7. The next window is the information window, that displays some information about
JVector, read it for your own interest, but it is not important. Once you have done reading,
or decided not to, click the next button in the bottom right corner.

8.

1zPack - Installation of JVector [;] m) ‘

s

'v Please read the following information :

LLll:lh‘la.nkyou for your interest in JVector. )
is file explains some brief general information of JVector,
and the process needed to build and run JVector.

JVector is a Vector {(wow!) based paint program. It aims to currently

provide fairly simple tools, simliar to MS Paint, but being Vector based.
New and exciting features, such as texturing, are more important then advance
node editing for this project.

JVector is written in, you guessed it, Java'! The project is hosted on
sourceforge.net (http://sourceforge.net/projects/t-bone-paint). This project
is an open source project of course, under the GPL (GNU General Public Licence).

Acknowl emenents :.]

(Made with 1zPack - http: ey izforge.coms)

[ QPrevious H QNex! ][ @Quit ]

9. Next, the license agreement for JVector will appear, please read this carefully. To install
JVector you must agree to the terms of the license, if you don’t agree, then you won’t be
allowed to install JVector.

I1zPack - Installation of JVector E] i

\) Please read the following license agreement carefully:

% GNU GENERAL PUELIC LICENSE ‘,A‘

Version 2, June 1991 E

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 US4
Everyone is permitted to copy and distribute werbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users. This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
Lthe GNIT_TLihrarw General Puhlic License instead. )
®1 accept the terms of this license agreement.

You can annlv it fo LTI

O | do not accept the terms of this license agreement.

(Made with IzPack - http: it izforge.comi)

[ QPrevious H @Next ” @Qun ]




10. The next window is very important, and might require your input. Here you decide where
you would like to install JVector. If you don’t really know where you should install it, then
ether ask someone, like an administrator, who does, or just accept the default installation
path. Once you have chosen the path, press next.

1z

"-.5 Select the installation path :

C:\Program FilesWVector

(Made with IzPack - hitp: Ay izforge.coms)

’ (3 Previous H € Next H €3 quit l

When you press next, the following box will appear, unless you are installing into a pre-
existing directory.
N

@ The target directory will be created :
C:\Program Files\Jvector2

Just click Ok here. If You are installing into a pre-existing directory, a window will come up
warning you that this is the case and that the installer will overwrite any files.

Warning !

@ The directory already exists ! Are you sure you want to install here and possibly overwrite existing files?

Message

If you understand that the files in the directory you are installing into will be destroyed, then
click Yes. Otherwise, install into a new directory by clicking No.




11. Now you need to choose which components of JVector you whish to install. Select an item
from the list to find out more information on what it does. Components that are needed for
JVector to work are greyed out and cannot be deselected

¢ Select the packs you want to install :
' Note: greyed packs are required.

Base 1.25MB
Image Plugins 793.45 KB

Description

Total space Required: 2.03MB

(Made with 1zPack - hitp: ity izforge.comi)

[ 3 Previous H € Next ][ €3 Quit ]

It is recommended tat you select all the components to install. Once you have selected all the
components you want installed, click next. (Step 11 continues on the next page).

12. Now JVector will be installed, this shouldn’t take more then a minute, and on any modern
computer, will only take around 5 seconds. When it is finished installing, as it is below,
click next.

570' Pack installation progress :

( ]

&9 Overall installation progress :

(Made with IzPack - hitp: iy izforge.comf)

[ Onexd || Gout |




13. This Step only occurs if you are on a Windows Operating System. If you are running a
Windows Operating System, the following panel will appear, if you are not running a
Windows Operating System, skip to step 13.

Select a Program Group for the Shortcuts:

Accessories k

Startup
create shortcut fol
(@) current user
O all users

|:] Create shortcut on the desktop

(Made with IzPack - hitp: ey izforge.com/)

[ QPrevious ][ QNext ][ GQu'ﬂ ]

Here you select where you would like to place the shortcuts to launch the program in the start
menu, there is also an option to create a shortcut on the desktop. These shortcuts provide
quick easy ways to launch JVector. Once you have decided, click next.

(Step 14 Follows on the next Page).




14. This is the final screen of the installation program, informing you that JVector installed
successfully. It does have one option though, a button that allows you to Generate an
Automatic Installation Script. See the Advanced Section at the end of this section, for more
details. Press Quit now to finish the installation of JVector.

& ¥ Installation has completed successfully.

&9 2n uninstaller program has been created in:
C:'\Program FilesWYectorninstaller

Generate an automatic installation script

(Made with 1zPack - hitp: Sy izforge.coms)

N

Advanced Installation Help
An Automatic Installation script allows you to install JVector with the installer, using the
same settings, as you just used then. This saves a lot of time if you need to install JVector
on multiple computers that are similar to each other. See the Advanced Section at the end
of this for more information. This feature will probably only be useful to you if you are an
administrator.




Running JVector

Windows

To launch JVector under a Windows Operating System, just use the shortcut from the start
menu, called JVector, or use the one on the desktop if you selected the option to create one
there during the installation.

‘ T » (2 Accessories »
_ & '_"_J Burning Tools »
g [3 Settings » (% Design »
p—4 AR .
A O sexcn y zeve'w'"w ' Launching JVector
QO = cmes
S [P— 5’ o . from the start menu
= ) p and Suppor (3 Inter .
~B A Meda Appicatons > under Windows XP
£ &7 Run... {4 Office Toos »
v
= . 4 Startup »
:-'z- 2] Log Off ) g
Ed | 0] Turn Off Computer... () Vector 45 JVedan\\S
) » & uninstall
m ) avector installaBon G... | [Z] Adobe AacbatProfe... |
Qe - 3 | D sewen [ rois | -
O C:Program Fles\vector MI>E
JVector Loading
On Windows XP.

Date Modfied: Today, 16 June
2004, 1:40PH
Size: 57748

M ) svector ns... | 4@ Google sea... | 2 logs m B CWINDG... | JPearpc0.2... | K ector0.18 T IO Qe 7ssem

Mac OS X and Linux
To Launch JVector in Mac OS X or Linux, go to the installation Directory of JVector, and
double click on the file JVector.jar. If JVector fails to launch, see the trouble shooting.

S
L3

JVector.jar




Using JVector

Understanding The Interface

oo O®OO®O®

e
2 0 0 @ 10
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Zoom: O ®out

9 ZoomLevel | 1/$
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1. Menu Bar — The menu bar stores the various commands for operating the program.

File Options Help

Mew. .. Chrl+N
Open... Ctrl+0
Close Ctrl+C
Save Ctrl+5
Save As...

Export... Ctrl+E
Exit Ctr+Q

2. Image Tabs —

(See the reference manual for a detailed explanation of each command).

File — Stores the commands to do with the image File’s. Opening them,
closing them...ect

Options — Stores the commands to do with JVector program options. So
far only contains one item, Preferences.

Help — Stores commands to do with Helping you.

This strip of Tabs provides access to all the open images. Each open image

has a tab on the strip, with there name on it, and clicking on a tab, changes to that image.




3. Drawing Tool Bar — Provides access to all the various drawing tools, used to actually draw
and manipulate images.

80000 ® OO

The tools are in order from left to right; Select Tool, Line Tool, Rectangle Tool, Oval Tool,
Polygon Tool, Text Tool, Delete Tool, Zoom Tool, Zoom Display.

See there individual description below for further details on them.

4. Image Editing Area — This is the area in which the actual image drawing and editing is
done. It is done through the tools and the mouse.

wiewsgeqw

5. Status Bar — This Bar down the bottom displays helpful information about features of
JVector when you place your mouse over them.

Use this tool to select shapes, to move, delete and modify them




6. Colour Swatch - Colour Swatches provide a grid of colours to choose from for your
convenience. If the colour you desire is not there, then clicking on the foreground or
background colour displays, will allow you to create your own colour. Clicking on a colour
in a swatch, sets the foreground colour to the colour clicked. See Colour Displayers for
information on how to set the background Colour.

Java | Jvector

7. Colour Swatch Selector — This is similar to the Image Tabs, but for Colour Swatches. It
allows you to change between multiple Colour Swatches with ease by clicking on there tab.

Java | Jvector

A

8. Colour Displayers — This Displays the currently selected background and foreground
colours, which are used when drawing. It also displays next to each colour, the current
opacity of that colour, which can be changed by you. The black bent double arrow allows
you to swap the foreground and background colour, so that you can set both using the colour
swatches, by flipping them.

‘/ Colour Swapper

Foreground Colour 1 UU Background Colour

Foreground Opacity / 10088 Background Opacity
<+“—

Clicking on either the background or foreground colour will bring up a colour selector so that

you can choose any colour you need, and are not limited to the swatches.

5

Swatches| HSB | ros

B ©n | 2398
Os | 1003
| OB | 203

R

G 0
(|

B 51

Custom Colour ——P»
Chooser

Preview

n - . Sample Text Sample Text

. . . Sample Text Sample Text




9. Current Tool Options — This area displays the options for the currently selected tool. See
each tools Option section below for more details.

Zoom: O &) out
Screenshot of the —>

Zoom Tool Options
Zoom Level: | 1/%

10. Tool Bar Handle — Both Tool bars, the drawing and the one that contains the colour
selection tools and tool options, have Handles. These Handles allow the Tool Bars to be
moved to any side of the screen, or even floated. To Do this, click and drag the handle to the
destination desired.

Tool Bar Handle ———————————— P

Draw Tool bar in —‘Drawmg Tools

Floating Mode
800000 @@




Image File Operations

Creating a New Image
To create a New Image in JVector, go to the File menu, and then click on the New... menu item.
Alternatively you can use the shortcut, Ctrl + N.

J¥ JVector 0.18

File Options Help
MNew... Ctrl+n
Open... Ctrl+0
Close Ctrl+C
Save As..,
Export... Ctrl+E
Exit Ctrl+Q

-

A dialog Box will then appear which requires that you set some of the image properties first.

New Image...
Name:
Image Size
YWidth: .
pixels v
Height: o
Presets
Presets: Line 1 v|
Cancel l [ Okay ]

¢ Name - This is what you would like to call your image. You can use any letters you would
like here.

*  Width — This is the Width/length that you would like the image to be. You can only enter
numbers here, and it must be between 0 - 5000

* Height — This is the Height that you would like the image to be. You can only enter numbers
here, and it must be between 0 - 5000

* Pixels — This is the units of length that you are specifying the image size in. Other units
include cm (metric) and inches (imperial).

* Presets — (At the moment this box does nothing, future development planned for it) This box
provides a list of typical image sizes, so that you don’t have to enter the most common ones
manually.




Opening an Image

To Open an image in JVector, go to the File menu, and then click on the Open... menu item.
Alternatively you can use the shortcut, Ctrl + O. A dialog box then opens that allows you to choose
an image to open. JVector images have the extension .jvi.

-~
r-’\e‘ Open an Image...
Look in: IIB My Documents ‘Z| I = ‘ | E
g “%» axialis Librarian
] ™ FileSharing Downloands
My Recent (™ My Design
Documents lD My Documents
= Lb My Games
@ lffﬁ My Music
Desktop My Pictures
@ My Videos
&\ D Programs
J () Snhagtt Catalog
My Documents ﬂfj Software Projects
|73 ¥r 12 SDD Major
:%! < standard jvi
My Computer [k
‘g File name: standard jvi
My Network
Places Files of type: | jvector Image ( jmi) ‘z | Cancel I




Saving an Image

When you have done creating your beautiful image in ease, you will want to save it. JVector allows
you to save it to its own native Vector format, preserving all the information so you can come back
and improve it another day. There are two different ways to save an Image, through the Save (Ctrl
+ S) option, or the Save As... option. The difference is this;

Save - saves the image to its previous location, that is, if you have already saved the image, it saves
it back to that image. This option is unavailable to images that are new and haven’t been saved, as no

file already exist to save to.

Save As... - Saves the image to a new file and location of your choice.

(e ]
Jy Save the Image
Save in: LB My Documents ‘7' I D ‘| E
3 ':' Axialis Librarian
L\b ™ FileSharing Downloands

My Recent ) My Design
Documents B My Documents

= Jb My Games
L J@ My Music
Desktop Iﬂ My Pictures
@ My Videos
L:] Programs

J I2) Snaglt Catalog
My Documents If_’] Software Projects
———— ||[[2) ¥r 12 SDD Major

:.%3 standard jvi

My Computer
\)i File hame:
My MNetwork

Places Files of type: | vector Image ( jmi) \v' | Cancel |




Exporting an Image

Exporting an image, allows you to save an image to different image formats, such as PNG, JPG...
This allows you to share them with other people easier, and use them on the web and with other
programs. The supported file formats you can export to are done through plugins. See the section on
Image Output Plug-ins for more detail. To export an image;

1. Go to File > Export or Ctrl + E.
2. When the dialog comes up, select where you would like to export the image to.
3. Then select the output format you want from the list at the bottom of the dialog.
4. Press Save.
(o ]
< Export the Image
Save in: [@ Desktop 2 ‘7' g > ‘| =

‘: ID My Documents
'_J hy Computer
My Recent | My Network Places
Documents () DONE
?E I2) General Crap

Desktop

\$

My Documents

4
File hame: example 2
My MNetwork

Places Files oftype: PG Image Format (jpg) 3 |v| | Cancel |

=
=




JVector Commands

Menu Commands

Command Short-Cut | Description

About JVector Displays information about JVector in a dialog. (eg
Version).

Close Ctrl + C Closes the current image.

Exit Ctrl + Q Quits JVector.

Export... Ctrl + E Export The current image to an external image format.

JVector Homepage Launches your default web browser and takes you to
the JVector homepage

New... Ctrl + N Launches the dialog to create a new JVector image.

Open... Ctrl + O Launches the dialog to open a JVector image.

Preferences... Ctrl + P Opens up the preferences dialog.

Save Ctrl + S Saves the current image to its last saved location, or the
location it was opened from.

Save As... Launches the dialog to save the current image to a new

location.

laces, still perform the same task (in essence).

Button Short-Cut | References Description
Escape Export Image Dialog Cancel the exporting of the current
image.
[m Escape New Image Dialog Cancel the creation of a new image.
p— Escape Open Image Dialog Cancel the opening of an image.
Preferences Dialog Cl'ose the prheferences dialog box,
without saving the changes you made.
Escape Sgwe Image As Cancel the saving of the current
Dialog image.
Enter New Image Dialog Conﬁrm .the settings and Create the
image with them.
Preferences Dialog Save the changes you just made to the
preferences, and close the dialog.
Enter Open Image Dialog | Try to open the currently selected file
as an image.
Enter Export Image Dialog Equrt the; current image to the file
specified in the dialog.
Enter Save Image As Save the current image to the file
Dialog specified in the dialog.




Tool Commands (Mouse)

These are the commands to change to the different tools, done by clicking on there button found in

the draw tool bar, with the mouse.

Button Tool Description
Select Change the current tool to the select tool.
Line Change the current tool to the line tool.

Rectangle | Change the current tool to the rectangle tool.

Oval Change the current tool to the oval tool.

Polygon | Change the current tool to the polygon tool.

ceseeeee®

Text Change the current tool to the text tool.
Delete Change the current tool to the delete tool.
Zoom Change the current tool to the zoom tool.

Colour Commands (Mouse)

These are commands to do with the colour tools, accessed through the mouse.

Button Tool Description
E Colour Click on a colour swatch to change the foreground colour
Swatches to the colour clicked on.
Foreground | Clicking on the foreground colour launches a dialog to
Colour choose a new foreground colour.
Background | Clicking on the background colour launches a dialog to
Colour choose a new background colour.

Opacity

Colour Click on the colour Swapper to swap the foreground and
Swapper background colours.
Foreground | Uses this spinner to change the opacity of the foreground

colour.

Background
Opacity

Uses this spinner to change the opacity of the background
colour.

Add
Swatch

Add a new Swatch to the swatch panel. (Not Functional at
moment).

Swatch

Remove the current swatch from the swatch panel. (Not
Functional at moment).

Swatch Info

100

o ¢

(N}
' Remove
l

Display some information about the current swatch.




Using The Tools

6 Using the Line Tool

The Line tool is used to draw lines. To use the line tool, select it, and then follow these steps;

1. Click and hold down the primary mouse button at the point you wish to start the line.
2. Keep holding and drag the mouse to the point where you wish the line to end.
3. Release at that Point.

Line Tool Options/Properties
The colour of lines is dependent on the currently set foreground colour, as is the line opacity. See
Setting Shape’s Colour’s for more details.

*  Weight — The Weight is the thickness of the line. So increasing the weight will result in a
thicker line been drawn.

Weight: 102

6 Using the Rectangle Tool
The Rectangle tool is used to draw rectangles. To use the rectangle tool, select it, and then follow
these steps;

1. Click and hold down the primary mouse button at the point you wish to start the Rectangle.
2. Keep holding and drag the mouse to the point where you wish the Rectangle to end.
3. Release at that Point.

Line Tool Options/Properties
The outline colour of rectangle is dependent on the foreground colour, while the fill is dependent on
the background colour.

*  Outline Weight — The Weight/Thickness of the outline of the rectangle. Increasing this value
increase the thickness of the outline of the rectangle.

Outline Weight: 4%




6 Using the Oval Tool

The Oval tool is used to draw ovals. To use the oval tool, select it, and then follow these steps;

1. Click and hold down the primary mouse button at the point you wish to start the Oval.
2. Keep holding and drag the mouse to the point where you wish the Oval to end.
3. Release at that Point.

Oval Tool Options/Properties
The outline colour of oval is dependent on the foreground colour, while the fill is dependent on the

background colour.

*  Qutline Weight — The Weight/Thickness of the outline of the oval. Increasing this value
increase the thickness of the outline of the oval.

Outline Weight: 4%

6 Using the Polygon Tool
The Polygon tool is used to draw polygons. A polygon is any shape with straight edges. To use the
polygon tool, select it, and then follow these steps;

1. Click, but don’t hold it, the primary mouse button on a point you wish to be a point of the
polygon.

2. Move the mouse to the next spot where you want to add a point to the polygon, and click on

the spot.

Keep repeating step two until you only have one more point you wish to add to the polygon.

4. Now for the last point, double click to add it, and also to end the polygon. Please note that the
speed of a double click required to end a polygon can be change under Options >
Preferences > General. See The Preferences Section for more information.

(98]




Polygon Tool Options/Properties
The outline colour of polygon is dependent on the foreground colour, while the fill is dependent on
the background colour.

*  Outline Weight — The Weight/Thickness of the outline of the polygon. Increasing this value
increase the thickness of the outline of the polygon.

Outline YWeight: 4%

O Using the Text Tool

The Text tool is very easy to use, but requires you to set all the options to do anything useful. To
actually draw the text though, you just use the one following step.

1. Click at the point where you want the left side of the text to be at. The text will start from
there, see the screenshot.

Dvector

Text Tool Options/Properties
The colour of the text is dependent on the foreground colour.

* Text — The text to draw.

* Font — The Font to draw it in.

* Style — The style to draw the text in, Plain, Bold, Italic, Bold & Italic.
* Size — The size to draw the text in.

Text:  J¥ector!
Font: |Arial Black v
Style: |Plain v
Size: 12 v
6 Using the Select Tool
The Select tool allows you to select and move shapes. Selected Shapes can also deleted and (coming

later) modified. To use the select tool, firstly you must select a shape, then once selected, you can
move that shape.

1. Select a Shape to manipulate by clicking on the shape.

2. To move the shape, click on it again, but this time hold down the primary mouse button, and
drag the mouse to move the shape.

3. Releasing the mouse button stops the move operation.

The select tool has no special options.




@ Using the Delete Tool
The Delete tool allows you to delete the current selected shape (selected by the select tool). This is

done as follows;

1. Select the shape you wish to delete with the Select Tool.
2. Click on the button for this tool in the tool bar, to delete the shape.

@ Using The Zoom Tool
The zoom tool allows you to zoom in and out of the image, from a range of 10% of its original size,

to 1600% of its original size. This is done as follows;

1. Select the Zoom tool
2. Setup the options, explained below.
3. Click on the spot you wish to zoom in on.

=Y

100%

The current zoom level is displayed just below the zoom tool.

Zoom Tool Options/Properties
Zoom: In or Out — Only one of these options can be selected, not both.

In — Select this option to Zoom ‘in’ on the image, increase its size.

Out — Select this option to Zoom ‘out’ of the image, decrease its size.
Zoom Level: Zoom level can be set between 1 & 5. It determines how much the image is
zoomed in or out of with each click. A zoom level of 1 means the image zoom increases or
decreases by 10% each click, while a zoom level of 5 will be 50% each click.

Zoom: O & out

Zoom Level: 19




Understanding Colour

Colour Swatches

To use colour swatches, you just click with your mouse, on the colour you want to set the foreground
colour to. Swatches can only change the foreground colour, to change the background colour; you
must use the flipping tool in the Colour Display Area.

Selected Colours Display — Foreground/Background Colour

This Area Provides a display for the currently selected foreground and background colour. See
below how foreground and background colour affects each shape. To set the background colour,
follow these steps;

1. Set the Foreground colour to the colour you desire for the background.

2. Flip the foreground and background colours, now the background colour is the one you
desire.

3. Set the foreground colour to the one you desire.

P Colour Swapper

2
ulls

Foreground Colour ___— Background Colour

Foreground Opacity €¢— Background Opacity

Foreground/Background Colour and Shapes
This is a table of how foreground and background colour affect each shape.




JVector Preferences

JVector has a few options that you can set for the program, located at Options Menu >
Preferences... (Ctrl + P). These options allow you to change some of the ways in which JVector
runs and performs its operations. The Options are broken into two categories, as follows;

»_% Preferences

__ | Mvector

® Startup Sfdrfup

# General

Show Splash Screen: ]

[ Cancel H Okay ]

Start-up
These are options that are related to the way in which JVector starts up, and it contains the following
options. (See above screenshot).

¢ Show Splash Screen: When JVector is loading, it displays a splash screen (screen shot
below) to notify you that it is still loading. However, this splash screen does very slightly;
slow down the loading of JVector, and because of this, many users, especially power users,
like to disable the splash screen to speed up the loading of JVector.

e

The JVector Splash Screen
showing while JVector loads.




General
These are general options to do with JVector, that don’t specifically fit into any of the other option
categories.

* Double Click Speed: This is the time in milliseconds, in which you must click twice, for a
double click to be registered. That is, the shorter this time, the harder it is to double click,
while the larger it is, the easier it is to double click. This timer only matters for when you are
drawing polygons, and need to double click to finish the polygon, as this is the only time
double clicks are used in JVector.

< Preferences
__ | Mvector
* Strtup Ceneral
#® General
Double Click Speed: I 300

[ Cancel ][ Okay ]




JVector Plugins
JVector can use plugins to provide additional image formats to export to. Plugins are stored in the
JVector Installation directory under, Plug-Ins\File Formats. Plugins are accessed through the export
feature for images.

You can find and download additional plugins if you would like, from the JVector homepage.

http://t-bone-paint.sourceforge.net/

Installing Plugins

To install plugins, firstly locate and download them from the internet. Pay close attention to any
documents that come with them, as they might tell you how to install that plug-in. However, most
plugins are installed in the exact same simple way, and if no documents are included telling you how
to install the plug-in, then follow this guide.

Download the plug-in; a plug-in should be one file, of extension .jar.

Place the plug-in in the Plug-Ins\File Formats directory in the JVector installation directory.
Restart JVector if it is currently open, if not, launch JVector.

Done!
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A new Image export type should now appear when you export an image.

Writing Plugins

If you are a keen developer, and would like to write your own image output plug-in for JVector, then
first make sure you can program Java, as this is the programming language you will need to use to
write a plug-in.

For the information and resources required to write a plug-in, head over to the JVector homepage.

http://t-bone-paint.sourceforge.net/




Error Reporting

If in the unlikely circumstance, you come across an error when trying to use JVector, or just a
problem or difficulty, then please contact us at the JVector website.’

http://t-bone-paint.sourceforge.net/

If you do email us about any problems, especially ones which you believe relate to an error in
JVector itself, please include the JVector log file. Please, when the error occurs, send us the log file
straight away, as it is over written each time you run JVector, so if you run JVector before sending
us the log file, we could loose valuable information.

The JVector log file is located in the JVector installation directory under, logs\logfile.log.

‘Q C:\Program Files\JVector\ogs V_

INFO Jvector [setupLog] - ***System Environment As Seen By Java®*¥
INFO Jvector [setupLog] - **¥*Format: PROPERTY = VALUE¥*¥*¥
INFO Jvector [setupLog] - java.runtime.name = Java(T™M) 2 Runtime

Environment, standard Edition

INFO Jvector [setupLog] - sun.boot.library.path = C:\Program
Files\Java\j2rel.4.2 04\b1n

INFO Jvector [setupLog] java.vm.version = 1.4.2_04-b05

INFO Jvector [setupLog] - java.vm.vendor = sun Microsystems Inc.
INFO Jvector [setupLog] - java.vendor.url = http://java.sun.com/
INFO Jvector [setupLog] - path.separator = ;

INFO IJvector [setupLog] - java.vm.name = Java HotSpot(TM) Client wM
INFO Jvector [setupLog] - file.encoding.pkg = sun.io

INFO JVector [setupLog] - user.country = AU

INFO IJvector [setupLog] - sun.os.patch.level = Service Pack 1

An example log file.

Re-occurring Errors

If the error you are planning to report reoccurs each time you perform a particular action, then you
can help us out more, by changing the level that JVector logs at, to be higher, so that we can more
easily discover and fix the error. To do this, follow these steps;

Open up the file, log.properties, with a text editor program

The Second line of the file should read, “log4j.rootCategory=INFO, A1”
Change this line to, “log4j.rootCategory=DEBUG, Al”

Now run JVector again, reproducing the error.

Now, send us the log file please, making sure not to run JVector again.

M

Thank you for your help and support in making JVector more stable.




Troubleshooting
System Requirements

Do I have a Java VM?
To check if you have a Java VM, open up your web browser, and head to this page,
http://java.com/en/download/help/testvm.jsp, if under the heading Test your JVM™ you can
see a box that displays some information in it and has a dancing triangle man with a red nose,
then Java is installed on your computer.

Congratulations. Java is installed on your system

Your Java configuration is:

Java vendor: Sun Microsystems Inc.
JRE Version: @
Qperating System: WiTdows XP

QS version: 5.1

What Version of Java do I have installed? Is this Good enough?
To check this, go to the same site as in 1, and see what JRE Version it says you have.
(circled in red above). If it is above 1.4.2 or equal, then your computer should be ready to
run JVector, as long as it meets the other requirements.

How do I install Java?
Open up your web browser and head to http://www.java.com:80/en/download/manual.jsp.
From there download the correct version of Java that is for your Operating System.

Installation

The Installation Program Will Not Launch
If this occurs, the first, follow the steps above in the System Requirements trouble shooting
section to make sure you have Java and a recent enough version of it installed. If you fail
this, then follow the steps in the same section to install one.

If you do have a Java VM of version higher or equal to 1.4.2, and you are running on
Windows, or Mac OS X, then you should update it to the latest version, and if you already
have the latest version, then you should reinstall it. If this fails, then you can follow the steps
below that are for Linux (this requires some technical knowledge), or contact us for support
through our web site. (http://t-bone-paint.sourceforge.net/).

If you are running Linux, or the above steps for Windows and Mac OS X fail, then try to
install JVector through the console as follows;




1. Open up the console.
2. Change the current directory to where the JVector-install.jar is located.
3. Now type the following command;

$ java —jar JVector-install.jar

Hopefully, this should launch the JVector installer program. If it doesn’t, then please contact
us for support through our web site. (http://t-bone-paint.sourceforge.net/). Please see the error
reporting section on how to ask for support first.

Please note that if this does work, then you will need to also launch JVector itself in the
following manner, although it would be best to write a simple command script to do this. See
the Running JVector trouble shooting section for more information.

Running JVector

Nothing Happens When the JVector.jar File is Double Clicked

If you managed to run the JVector installer by just double clicking JVector-installer.jar, but
double click JVector.jar fails to launch the program then most likely you have a Program
error. Firstly, reinstall your Java VM. If this fails, then please contact us for support through
our web site. (http://t-bone-paint.sourceforge.net/). Please see the error reporting section on
how to ask for support first.

If you had to launch the JVector Installer through the consol, then you can use the same
method here. Open up the consol to the JVector installation directory, and run the following
command;

$ java —jar JVector.jar

If this works, then please contact us for further support, or just use the above method each
time.

Using JVector

When trying to export an image / plug-ins are reported to be corrupt.

If this occurs, then one or more of your output plugins is/are corrupted. Please follow these
steps to fix the problem.

1. Go to your JVector installation directory.

2. Go to the folder Plug-Ins and then File Formats (Plug-Ins\File Formats).

3. Remove all the files from that directory to a temporary directory that you have
created, outside the JVector installation directory.

4. Add back to the File Formats directory, one plug-in.

5. Run JVector, and try to export an Image, if an error is reported, then you know that
that plug-in is corrupt. So delete it, recording which one it was so that you can
download it again off the internet. If JVector successfully exports the image, you
know the plug-in is okay, so leave it in the directory.
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Repeat steps 4 — 5 for each plug-in to remove the corrupt ones.

7. Now that your plugins should all be working, go to the JVector homepage, and
download the plugins that were corrupted.

8. Place them back in the File Formats directory, and JVector and all the plugins should

now be working.

If this doesn’t fix your problem, please contact us through JVector’s website, to receive
technical support. Please see the error reporting section on how to ask for support first.




